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Parts list 

Quantity Description 

1 MAF Fusion module 

1 MAF Fusion harness, 6 ft leads w 8 ft bulk-head USB cable 

1 USB bulk-head cap 

1 USB cable, USB-A to Mini-B 2.0 Cable, Black, 6ft 

1 USB flash drive (with product software) 

2 Stainless machine screw, 8/32 x 5/8” 

2 Stainless nylon-insert lock nut, 8/32” 

22 Heat shrink tube, cut 

Optional items 

Part # Description 

104847-USCAR3L Fuel injector wiring harness w loom, 3 cylinders, USCAR connector 

104847-USCAR4L Fuel injector wiring harness w loom, 4 cylinders, USCAR connector 

104847-Minitimer3L Fuel injector wiring harness w loom, 3 cylinders, Minitimer connector 

104847-Minitimer4L Fuel injector wiring harness w loom, 4 cylinders, Minitimer connector 

104847-Multec2-3L Fuel injector wiring harness w loom, 3 cylinders, Multec 2 connector 

104847-Multec2-4L Fuel injector wiring harness w loom, 4 cylinders, Multec 2 connector 

TBD MAF Fusion harness connector kit 

 

Recommended tools 

Part # Description 

 Wire crimping tool 

 Wire stripping tool 

 Vehicle calibration software (EFILive, HP Tuners, SCT, etc.) 

 Windows 7, 8 or 10 PC 
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MAF Fusion Features: 

• Inputs 

• Two frequency type MAF sensor inputs (0 to 20,000 Hz input range) 

• RPM input (with software selectable pull-up circuit), 0-12,000 RPM input range 

• MAP/boost sensor input (user configurable for most 0-5 volt linear output MAP and pressure sensors) 

• Data log activation 

• Built in USB cable with remote bulk-head connector (for live view of data, reprogramming MAF Fusion & 
reading data logs) 

• Outputs 

• Frequency type MAF signal output (0-20,000 Hz) 

• Voltage type MAF signal output (0.1-4.9 volts) 

• Bank 1 injector control (up to 4 high impedance injectors) 

• Bank 2 injector control (up to 4 high impedance injectors) 

• Auxiliary injector driver signal (Push/Pull +12V, low current) 

• LED indicators for power, status of MAF sensor inputs & error condition notification built into enclosure 

• MAF sensor signal related features: 

• Accepts one or two frequency type MAF sensors 

• Outputs for frequency and voltage type MAF sensors 

• When using two MAF sensors, MAF input signals can be averaged, combined or subtracted from each other 

• Allows the user to adjust or scale the MAF sensor output across the entire output range or anywhere in 
between (up to 250 individual adjustment points) 

• Fast and slow response filtering of each MAF input at each frequency step (up to 250 points) 

• MAF sensor curves can be different for all inputs and outputs 

• MAF frequency input and output range from 0 to 20,0000 Hz 

• Up to 250 calibration data points for each MAF curve (in and out) 

• Auxiliary injector control features: 

• Directly control up to 8 high impedance injectors (up two banks of four) 

• Additional driver output signal for use with external injector driver modules  

• Auxiliary injector control by MAP or airflow vs RPM 

• Up to 21 x 21 table size with user defined axis break points for RPM and load 

• Auxiliary injector control can be used on its own or in conjunction with the MAF sensor functions 

• Additional features: 

• Precision, high speed microcontroller operation 

• Data logging of all inputs and outputs 

• 10, 20, 50 or 100 samples/second (Hz) user selectable sample rate 

• Live data view mode for monitoring of inputs and outputs 

• On-board barometric pressure sensor 

• On-board module temperature sensor 

• Includes universal style 6’ wiring harness 

• Automotive temperature grade components 

• Fully epoxy potted construction for increased durability 

• Compact design with black hard coat anodized aluminum enclosure 

• Free Windows PC software for module programming, viewing live data & reading logged data 

• One year limited warranty 
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Applications: 

• Scaling, calibrating and/or filtering of mass airflow sensor signals 

• Scale the entire curve or individual frequencies or frequency ranges 

• Converting from voltage output based mass airflow (MAF) sensors to frequency type MAF sensors 

• Allow vehicles that require voltage type MAF sensors to use the more common frequency type MAF sensors 

• Converting from one type of MAF sensor to another when access to the MAF calibration tables in the engine control 

module (ECM) is not available 

• Installing air intake systems with different MAF sensor calibration curves without reprogramming the ECM 

• Custom air intake systems with two MAF sensors on vehicles where the engine management system is only able to 

recognize one MAF sensor. Reasons for the need for twin MAF sensors may include: 

• Reduced inlet restriction 

• Better inlet duct work packaging 

• Better sensor location (especially in twin turbocharged applications) 

• Better low airflow MAF sensor resolution 

• Auxiliary fuel control, especially in high power applications where the original engine controller is not able to 

recognize the actual airflow values and/or is not able to be calibrated for the needed fuel injector flow rate due to 

software limitations. 

• Examples: 

• 1994-2008 model year Corvette and other GM applications 

with 512 grams/second maximum ECM/PCM recognized/

measured airflow limit 

• 2004-2008 model year Corvette and other GM applications 

with a 8 grams/second maximum ECM recognized injector 

flow rate limit 

• Auxiliary port fuel injection (PFI) control in direct injection (DI) engine 

applications where available injectors and/or fuel pumps may not be able to 

supply the required fuel flow. 

• Airflow or boost based water or alcohol injection control 

• Airflow or boost based intercooler radiator water spray/evaporative cooling system control 

• Flow bench testing of MAF sensors including comparison testing of MAF sensors 

• Provides sensor power, live data view, data logging and signal output capability (as a voltage and a 

frequency) 

• Use to compare or calibrate one MAF sensor using a second known output signal MAF sensor 

• Engine or chassis dynamometer applications where you want airflow to the ECM also to be recorded by the 

dynamometer data acquisition system 
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Software Installation: 

The MAF Fusion software requires Windows 7 or newer. MAF Fusion works with 32 bit and 64 bit 

systems. It is not compatible with Windows XP or older Windows software operating systems.  

We recommend installing the software as a PC administrator. You must have proper usage rights to 

install new software on the PC. 

If you already have the software installed and are updating to a newer version you will need to 

uninstall the existing software first (see the next section for uninstall instructions). 

Insert the supplied USB drive into the PC or download the installation software from the Internet. If 

you downloaded the software, unzip the files and save them to a local drive or a USB flash drive. 

The install software may be run directly from the supplied USB drive (no need to make a local copy) 

Double click on “MAF Fusion III Setup”  (version 2_0_0 

shown). 

NOTE—you may get an “Error reading from file…” error 

during the install process if you try to install the software 

from some network and cloud drives. If this occurs, make a 

local copy of the installation software and run from the local drive. 

Welcome to the MAF Fusion Setup Wizard dialog box will 

appear. 

Click Next. 

Select Installation Folder dialog box will appear. 

We recommend leaving it saved in the default Windows 

location. 

Select if the software should be installed for just this user 

login or all PC user logins (Everyone or Just me). 

Click Next. 
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Confirm Installation window appears. 

Click Next 

Installing MAF Fusion window will open. 

Depending on the operating system and security settings, 

you will likely get a window asking “Do you want to allow 

this app from an unknown publisher to make changes to 

your device”. 

Click “YES” 

If you wait too long to click yes, you will get an “Installation 

Interrupted” window. Just press close and start the process 

over if this happens. 
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The software will then return to the installing MAF Fusion 

window. Depending on the speed of your PC and the drive 

it is being installed on, you may only briefly see this 

window. 

The software will then indicate that the MAF Fusion 

software installation is complete. 

MAF Fusion will create a Start menu group called “MAF 

Fusion” with links to the MAF Fusion software and the 

uninstall utility. 

MAF Fusion will also create a desktop shortcut. 

A folder in the user documents folder will have been 

created as well. 

Initially the folder will have the following contents. 

After the software is first opened a Config folder will also be 

created in the same MAF Fusion folder found in the local 

user documents directory. 
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Uninstalling the MAF Fusion software: 

NOTE: Un-installing the software from the uninstall menu will not erase any stored data logs or 

setup files but we always recommend backing up any data before un-installing the software if you 

have critical data stored in the local user folders. 

Go to the MAF Fusion Start folder or the Add/Remove 

programs section of the control panel. 

Select Uninstall MAF Fusion.exe 

Windows installer dialog box will prompt you “Are sure you 

want to uninstall this product”. Click YES. 

“Windows Installer”, “Preparing to remove…” dialog box will 

appear (depending on PC, anti virus software and other 

security settings this dialog box may take a little while). 

Please wait while Windows configures MAF Fusion window 

will appear. 

Depending on operating system and security settings, a 

User account control window will likely appear. Click YES to 

allow the software to be uninstalled. 

The software will then return to the “Please wait while 

Windows configures MAF Fusion” window. When the 

progress bar gets to the end and this window closes, 

uninstall is now complete. 

The desktop icon, Start menu items and the program files will have been removed. 

The MAF Fusion folder in Documents will still exists with any user generated data and the MAF 

sensor base CSV files. 
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Main menu options 

File 

From the File menu option you are able to Open existing 

MAF Fusion user settings files (.mfs files), Save new user 

settings files, Save As user settings as a new file name, 

Import CSV Data for the MAF sensor calibration curves, 

Export CSV Data of the MAF sensor calibration curves, 

Read user settings files from the MAF Fusion controller, 

Write new user settings files to the MAF Fusion controller 

and Exit the program. 

Data 

From the Data menu option you can select to Read logged 

data from the controller, Open an existing data log file or 

Save the current log data to a file. 

 

Option 

From the Option menu you can configure if the software 

starts from a previously loaded file each time or if it starts 

from a blank new file each time. If you need to create a new 

user settings file from scratch, unselect the “Load Previous File” option and restart the software.  

Controller 

From the Controller menu you can select to update the 

firmware of the MAF Fusion controller. If major software 

updates occur that result in the software version main 

number (the first number in the revision number indicated by an “X”, X_0_0) not matching the first 

digit of the firmware revision number, then a firmware change is required. 

Help 

From the Help menu you can see the current software 

version number and access the user manual and wiring 

diagrams (not yet added). 

MAF Fusion software 

Bottom of software window (available in all software tabs) 

In the bottom section of the MAF Fusion software window (in all tabs) you are able to see if a 

controller is connected, the firmware version of the controller (if one is connected) and the name of 

the user settings file (.mfs file) currently being viewed in the software.  
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Main tabs in MAF Fusion software: 

Config 

The Config tab is used to setup the main MAF 

Fusion configuration settings for MAF 

configuration, RPM input, data log rate and MAP 

sensor calibration. 

MAF Input1 

MAF Input1 is used to define the calibration of the 

#1 input MAF sensor. 

The MAF Fusion software uses this lookup table to 

determine the sensed airflow based on the 

frequency readings from input 1. 

This tab is also used to adjust the signal filtering for MAF Input 1. 

MAF Input 2 

MAF Input2 is used to define the calibration of the 

#2 input MAF sensor. 

The MAF Fusion software uses this lookup table to 

determine the sensed airflow based on the 

frequency readings from input 2. 

This tab is also used to adjust the signal filtering for MAF Input 2. 

MAF Out Frequency 

Based on the input mode selected and the airflow 

readings from MAF1 and MAF2, the MAF Fusion 

calculates the correct MAF output airflow value and 

then uses this lookup table determine the airflow to 

frequency correlation for the frequency type MAF 

sensor output signal. 
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MAF Out Voltage 

Based on the input mode selected and the airflow 

readings from MAF1 and MAF2, the MAF Fusion 

calculates the correct MAF output airflow value and 

then uses this lookup table determine the airflow to 

voltage correlation for the voltage type MAF sensor 

output signal. 

 

Aux Fuel 

The auxiliary injection control table is used to 

control the auxiliary injector outputs. These outputs 

are: 

• Aux Injector Output #1 

• Aux Injector Output #2 

• Aux Injector Out Low Level 

The table is RPM vs load where load can be 

selected as airflow (grams/second) or manifold air 

pressure (PSI). The values in the table are in 

milliseconds (ms). 

Simulation 

The simulation tab is used to allow the user to 

calculate what the MAF Output values should be 

based on the MAF configuration and the MAF Input 

tables. The user can enter the frequency values in 

directly for MAF1 and MAF2 or can use the slider 

bars on the left to move across the range. The 

slider bars can be synchronized so that the frequency values are the same or 

unsynchronized so that MAF1 and MAF2 frequency values can be different. 
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Data 

The data tab is used to view logged data in 

numeric and graph formats. 

The data tab is also used to export the log data to 

a CSV file or to the clipboard. 

From the Data tab you can also extract the setup 

file that was in the MAF Fusion when it was logging the data. 

Live Data 

The Live Data tab is used to view live real time 

data from the MAF Fusion controller. Available data 

includes: 

• MAF1 raw frequency 

• MAF1 filtered frequency 

• MAF1 airflow 

• MAF1 filter value 

• MAF1 compensation value 

• MAF2 raw frequency 

• MAF2 filtered frequency 

• MAF2 airflow 

• MAF2 filter value 

• MAF2 compensation value 

• MAF Output Frequency 

• MAF Output Voltage 

• MAF Output airflow 

• Engine RPM 

• Battery voltage 

• MAP sensor voltage 

• MAP sensor PSI 

• Barometric pressure 

• MAF Fusion controller temperature 

• Auxiliary injector pulse width 
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MAF Fusion software file types: 

The MAF Fusion software has several different types of files it can save or open. 

The primary file types and the corresponding windows extensions are: 

Description    Windows file extension 

User setup file   .mfs 

Log data file    .mfd 

MAF sensor calibration data file .csv 

Log data export file   .csv 
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Note: 

• Group #1 is split into two sections in the above list because some wires are from the upper row of 13 pins in the connector and 
some wires are from the lower row of 13 pins in the connector. 

• The following three wires are not part of any group (bundle): 

• MAF Analog out (10, gray) 

• Data Log Activation Input (15, purple) 

• Tach Signal Input (17, white) 

• The above colors are for the second generation harness that added a color stripe to repeat colors for easier identification. If 
you have an early harness the primary color is the same as above. 

MAF Fusion Connector End View 

 
  

Harness Connector End View (as viewed from back of connector) 

 
  

Pin Group Wire Color Wire Size Function 

1 1 Green 18 AWG / 0.8 mm^2 Aux Injector Output #2, Ground 

2 1 Tan 20 AWG / 0.5 mm^2 Aux Injector Out, Low Level, Push/Pull +12V 

3 1 Blue 18 AWG / 0.8 mm^2 Aux Injector Output #1, Ground 

4 2 Light blue 20 AWG / 0.5 mm^2 CAN High 

5 2 Light green 20 AWG / 0.5 mm^2 CAN Low 

6 USB Black 24 AWG / 0.2 mm^2 USB Ground 

7 USB Red 24 AWG / 0.2 mm^2 USB Power, +5 volt 

8 USB White 28 AWG / 0.08 mm^2 USB Data, - 

9 USB Green 28 AWG / 0.08 mm^2 USB Data, + 

10 Single Gray 20 AWG / 0.5 mm^2 MAF Analog Voltage Signal Out to ECM 

11 3 Blue w red 20 AWG / 0.5 mm^2 MAF Frequency Signal Out to ECM 

12 3 Red w black 20 AWG / 0.5 mm^2 MAF Out +12V from ECM  [MAF Fusion power] 

13 3 Black 20 AWG / 0.5 mm^2 MAF Out Ground from ECM   [MAF Fusion ground] 

14 1 Black w blue 18 AWG / 0.8 mm^2 Aux Injector Ground 

15 Single Purple 20 AWG / 0.5 mm^2 Data Log Activation Input [+12V activation] 

16 1 Black w white 18 AWG / 0.8 mm^2 Aux Injector Ground 

17 Single White 20 AWG / 0.5 mm^2 Tach Signal Input 

18 4 Pink 20 AWG / 0.5 mm^2 MAP Sensor Signal Input 

19 4 Red 20 AWG / 0.5 mm^2 MAP Sensor Power, +5V 

20 4 Black w yellow 20 AWG / 0.5 mm^2 MAP Sensor Ground 

21 5 Green w black 20 AWG / 0.5 mm^2 MAF #2 Signal Input 

22 5 Orange w green 20 AWG / 0.5 mm^2 MAF #2 +12V 

23 5 Brown w white 20 AWG / 0.5 mm^2 MAF #2 Ground 

24 6 Yellow 20 AWG / 0.5 mm^2 MAF #1 Signal Input 

25 6 Orange 20 AWG / 0.5 mm^2 MAF #1 +12V 

26 6 Brown 20 AWG / 0.5 mm^2 MAF #1 Ground 
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MAF Fusion wiring: 
 

Main power/ground 

• The MAF Fusion gets primary power and ground from the ECM mass airflow sensor power and 

ground connections (MAF Out, group 3 wires). If you are not connected to the ECM MAF sensor 

input connector or want to power the MAF Fusion on a test bench then connect switched and 

fused +12V power to pin 12 (red wire) and ground to pin 13 (black wire). 

 

MAF sensor signal to the ECU 

• When being used to output a frequency type MAF signal the MAF Fusion should be connected 

directly to the ECU’s MAF sensor power, ground and signal wires. These wires are in Group 3. 

 

MAF Analog Voltage Signal 

• The MAF Fusion can provide a 0-4.9 volt analog output voltage for a MAF signal. This can be 

connected to an ECM that is expecting an analog voltage type MAF signal or it can be connected 

to an external data acquisition system to monitor the airflow. 

• The MAF analog voltage signal can be found on pin 10, gray wire. 

 

MAF sensors into MAF Fusion (Group 5 & 6) 

• When being used to output a MAF signal, the MAF Fusion must be connected to one or two 

frequency type MAF sensors. MAF sensor input 1 are the Group 6 wires and MAF sensor input 2 

are the Group 5 wires. 

 

Manifold Air Pressure (MAP) sensor, Group 4 

• The MAF Fusion can be used with a dedicated stand-alone MAP sensor or, in many cases, it can 

connect to an existing MAP sensor already in use by the primary ECU. 

• For dedicated stand-alone ratiometric MAP sensors that need a regulated 5 volt source, the MAF 

Fusion provides 5 volt regulated power for the MAP sensor on pin 19, sensor ground on pin 20 

and pin 18 is the sensor signal. For dedicated stand-alone non-ratiometric sensors that are 12 

volt powered, the sensor should get 12 volt power from a switched and fused 12 volt source and 

then the ground and signal wires should connect to the MAF Fusion. 

• The MAF Fusion can also be used with an existing pressure sensor in many vehicles. If you are 

connecting to an existing in use sensor, only connect the MAP sensor signal wire from the 

vehicle to the MAP sensor signal wire on the MAF Fusion, Pin 18. Do not connect anything to the 

MAP sensor +5 volts or ground on the MAF Fusion. The MAF Fusion has been designed to have 

sufficient impedance to not impact the signal in most vehicle applications but it is always a good 

idea to double check that connecting to the vehicle MAP signal does not impact the measured 

MAP signal and voltage as seen by the OEM ECU. If this occurs the MAF Fusion may cause 

diagnostic codes or calibration issues and it is recommended that you use a dedicated MAP 

sensor instead. 
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RPM signal 

• An RPM signal is required when you want to use the auxiliary injector output capability of the 

MAF Fusion. You may also want to connect to the RPM signal in order to be able to data log that 

data in combination with the other data channels. 

• Connect wire/pin 17 (white wire) to a suitable RPM signal such as a tachometer signal wire. 

• If the MAF Fusion is the only device on the tachometer output wire you may need to 

enable the internal pull-up circuit in the MAF Fusion in the MAF Fusion software. Do NOT 

enable the internal pull-up if the circuit already has a pull-up in the system. 

 

Aux injectors 

• Output 1 

• Wire your injectors to Output 1 with the GROUND side of the injectors connected to pin #3 

(blue wire) and the +12 volt side of your injector harness connected to ignition switched 

and fused +12 volt power. 

• No more than four (4) high impedance (10-14 ohm each) injectors should be connected to 

this output. Do not use low impedance injectors. 

• Output 2 

• Wire your injectors to Output 2 with the GROUND side of the injectors connected to pin #1 

(green wire) and the +12 volt side of your injector harness connected to ignition switched 

and fused +12 volt power. 

• No more than four (4) high impedance (10-14 ohm each) injectors should be connected to 

this output. Do not use low impedance injectors. 

• Aux Injector Ground 

• When using the MAF Fusion to control auxiliary injectors make sure you also connect the 

two Aux Injector Ground wires (wire/pin 14 black wire and wire/pin 16 black wire) to a 

suitable chassis ground. 

 

Low level output 

• This output is a low level, Push/Pull, +12V output. It is not designed to connect directly to 

injectors. It should connect to the control input on an external injector or solenoid controller. 

• This output can also be used to PWM control a solid state relay in order to provide PWM control 

of a pump or other device (using the PWM Output Table option). 

 

Data log enable 

• Data logging is enabled via the violet “Data Log Activation Input” wire on pin 15 of the controller. 

Data logging begins when you apply +12 volts to this wire and ends when you remove +12 volts 

or when the data logging memory is full (which ever happens first). 
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Creating your first new MAF Fusion user setup file: 

This section is intended to be a quick example of how to create a new user setup file. For more in-

depth explanations please go to the menu and tab specific sections of the instructions. 

To create a new MAF Fusion user setup file, make sure the software 

is set to not open a previous file in the Option>Program Start menu. 

Now close and open the software again. You now have a default 

starting file. “untitled.mfs” will show in the bottom right corner of the 

MAF Fusion software window. 

In the “Config” tab you will first need to select how you want the MAF 

Fusion controller to interpret the MAF sensor signals (assuming you 

have a MAF sensor connected). 

If you are only connecting to one MAF sensor, select the MAF input 

corresponding to how you have it wired to the MAF Fusion (Input 1 

or 2). 

If you have two MAF sensors in parallel (side by side), you typically 

want to combine the inputs from the two MAF sensors to generate a 

new combined flow output. Assuming this is the case, select 

Combine inputs. 

If you have two MAF sensors in series (in line with each other) then you typically want to average 

the inputs so select Average inputs. 

If you are using the MAF Fusion for auxiliary injector control then you will need to connect an RPM 

signal to the MAF Fusion and you will need to calibrate the RPM signal via the “Tach Input Pulse Per 

Revolution” setting. You will also need to determine if you need to enable a pull-up circuit in the MAF 

Fusion. Make sure you do NOT have more than one pull-up circuit in the system. See the more 

detailed section on the Config tab and RPM input selection if you need more information. 

If you plan to data log any data you will need to decide what sampling rate you want to use. The 

finer the sampling resolution the shorter the data log. 

If you are using the auxiliary injection control function and will be using manifold air pressure (MAP) 

as your load axis then you will need to connect and calibrate a MAP sensor to the MAF Fusion. If 

you are using MAF as the load point you do not need a MAP sensor (but you must then be 

connected to a MAF sensor). Select the sensor type you are going to connect to (if applicable). 

You may choose to type notes for this configuration in the notes area. A separate notes area exists 

for the Config, MAF Input 1, MAF Input 2, MAF Out Frequency and 

MAF Out Voltage tabs. 

You must now enter the calibration data for the MAF sensor(s). This 

is done using the MAF Input1 and/or MAF Input2 tabs. You can enter 

the MAF data several ways—import from an existing CSV file 

(examples are provided by PSS), copy and paste from another 

program or manually enter the values. If you are manually entering 

the data or copying and pasting from another program you need to 

first set the MAF sensor calibration table size. To do so go to the 
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“MAF Input[1 or 2] Table Size” and enter the correct number of cells (rows) and then click “Apply”. If 

you are importing a MAF calibration using the File>Import CSV Data menu then you do not need to 

set table size—that will be set automatically when you import the data. 

The frequency data and the airflow data must be in order from low to high. You can have up to 250 

steps (rows) in the calibration and the step sizes (the frequency values) do not need to be in even 

step sizes. Frequency values can be from 0 to 20,000 Hz. Airflow values are in grams per second 

(gps) and can range from -5 gps to 2,000 gps in 0.00001 gps increments. 

Now that you have the MAF Input table or tables configured, if you 

plan to output the MAF sensor signal to an ECM or other device you 

need to configure the MAF Out table(s). If you are sending the MAF 

data as a frequency signal, you need to populate the MAF Out 

Frequency table. If you are transmitting the airflow data as a voltage 

output then you need to populate the MAF Out Voltage table. So that 

the ECM reads the correct airflow, you normally want the values in 

the MAF Out table to match the values in the ECM MAF sensor 

calibration table. The step sizes do not need to be the same but the 

effective curve should be the same if you want the ECM to read the 

same airflow as the MAF Fusion module is calculating. You only need to calibrate the MAF Out table 

for the type of MAF output you will be connected to. 

If you plan to use the auxiliary injector control feature you now need 

to populate the “Aux Fuel” tab values. 

The first thing you need to decide is what your load axis will be. Load 

can either be a manifold air pressure (MAP) or mass air flow (MAF). 

To select your load axis, go to the upper left corner of the Aux Fuel 

tab and select the load axis you want from the pull down menu under 

“Aux Fuel Table Select” - the choices are “MAF Out grams/second” or “MAP psi”. 

Once you have selected the load axis you will want to set the RPM and load breaks to the values. 

You may have up to 21 columns or rows. The step size between each row or column does not need 

to be the same but they must be in increasing order and you may not have duplicate row or column 

headings. 

You then want to set the minimum injector off time (in milliseconds) and the minimum injector on 

time (also in milliseconds).  

Now you are ready to populate the auxiliary injector control table with the desired injector pulse 

widths. Each injector output is pulsed once per engine revolution. The table will not let you enter 

values that exceed the maximum available pulse width (given the engine rpm and off time value). It 

will also not let you enter values that are less than the minimum on time. 

Now go to the File pull down menu and select Save to save your file. You can also use the “CTRL-S” 

keyboard command or click on the save icon (looks like a floppy disk). 

You have now completed creating your first user setup file. 
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Config tab: 

 

The “Config” tab is used to set the main MAF 
Fusion configuration settings including: 

• MAF Input Mode 

• Tach Input Pulse Per Revolution 

• Tach Input Pullup Enable 

• Data Log Samples Per Second 

• MAP Sensor Configuration 

MAF Input Mode 

MAF Input Mode is used to tell the MAF Fusion controller how to interpret the MAF sensor signals. 
The input mode options are: 

• Average inputs 

• Combine inputs 

• Subtract (MAF Input2 from MAF Input1) 

• MAF Input #1 Only 

• MAF Input #2 Only 

Average inputs 

In the “Average inputs” mode the airflow values from MAF Input1 and 

MAF Input2 are averaged. The MAF Out Frequency and the MAF 

Out Voltage are then based on this average airflow value. This mode 

is normally used when two MAF sensors are installed in series (that 

is, one after the other) and you are using the MAF Fusion controller 

to average the data from the two sensors. 

Combine inputs 

In the “Combine inputs” mode the airflow values from MAF Input1 

and MAF Input2 are combined (added together). The MAF Out 

Frequency and the MAF Out Voltage then based on this combined 

airflow value. The “Combine inputs” mode is usually used if you have 

two MAF sensors and they are installed in parallel (that is, side by 

side) such that part of the air entering the engine travels through one 

sensor and part of the air entering the engine travels through the 

other sensor. 

Picture courtesy of Magnuson Products LLC 
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The “Combine inputs” mode allows you to have twin inlet air intakes with individual MAF sensors on 

vehicles with an engine control module (ECM) that is not able to recognize more than one MAF 

sensor. 

Reasons for wanting to run two MAF sensors may include: 

• Two MAF sensors to provide reduced inlet restriction in high horsepower applications. 

• Easier packaging of MAF sensors in air inlet duct work where a smaller diameter MAF and the 

subsequently shorter straight section of ducting required before and after the MAF may make two 

smaller MAF sensors easier to package then one large sensor. 

• Better airflow resolution and accuracy of two smaller MAF sensors compared to one large MAF 

sensor under low airflow conditions such as idle and light load cruising. As the MAF sensor 

housing gets larger, the sensor has to estimate the flow from a smaller and smaller percentage of 

the unmeasured airflow. In addition the larger sensor tube diameter (cross sectional area) is for a 

given amount of airflow, the lower the velocity of the airflow. At very low air velocities the sensors 

are especially sensitive to turbulence and sensor positioning. 

• Packaging of the MAF sensors before the turbochargers on twin turbocharged engine 

applications in order to: 

• Keep the MAF sensor away from air that may be contaminated with oil from turbocharger 

seal leakage. 

• Install the MAF sensors in the low pressure side of the system instead of in the high 

pressure, high temperature post turbocharger side of the system (for durability and/or 

measurement reasons). 

Subtract (MAF Input2 from MAF Input1) 

In “Subtract” mode the airflow value from MAF Input2 is subtracted from the airflow value of MAF 

Input1 and then this airflow value is used to generate the output values for MAF Out Frequency and 

MAF Out Voltage. 

This mode can be used to: 

• Compare two MAF sensors on a flow bench. 

• Subtract the airflow coming from a crankcase ventilation source (so effectively inert gas causing 

MAF Input1 to read higher than it should) using a small diameter MAF sensor in the PCV line. 

• Subtract the airflow exiting the duct work via a blow off valve or boost bypass valve. 

MAF Input #1 Only & MAF Input #2 Only  

MAF Input #1 Only and MAF Input #2 Only modes are used if you only want to use one input sensor 

to the MAF Fusion to control the output signals. 

In MAF Input #1 Only and MAF Input #2 Only modes only the data from the respective sensor 1 or 2 

is used to calculate the total airflow and generate the MAF Out Frequency and the MAF Out Voltage. 

One of these two modes is normally used when you have a single MAF sensor in the vehicle and 

are using the MAF Fusion to: 

• Modify the sensor calibration curve to change sensor readings on systems where you can’t or do 

not want to recalibrate the sensor calibration data in the ECM. This may be to fix fuel trim issues 
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at idle or other load conditions and/or to change fueling at wide open throttle conditions with an 

existing MAF sensor or to adapt an all new sensor to the vehicle. Since the MAF Fusion software 

allows you to change the calibration data in up two 250 frequency and voltage steps, you are 

able to make changes in very small airflow areas or the entire table as desired. 

• Install air intakes that have a different MAF sensor output curve without having to reprogram the 

ECM. 

• Filter MAF readings in specific airflow/operating frequency ranges due to turbulence due to air 

intake design and/or MAF sensor placement, airflow reversion caused by MAF sensor 

placement/throttle body location/camshaft overlap or other causes of potentially erratic airflow 

values. 

• To control auxiliary fuel injection in high horsepower applications where the OEM engine 

controller does not understand airflow past a certain value, understand injector flow rates past a 

certain injector flow rating and/or understand total fuel flow values above a certain value. 

When in MAF Input1 or MAF Input2 mode you may still have two sensors connected. The system 

will still calculate the airflow from the second sensor and log that data but the other sensor’s data will 

not be used for any of the MAF Out data and will not be used for the Aux Fuel table control.  

Since the second sensor input is still being calculated, displayed and logged when in single sensor 

mode, you can also use this mode to generate the calibration curve for one sensor based on the 

calibration curve of a known sensor (the airflow and frequency of one sensor is known but the airflow 

to frequency output of the other sensor is not known). By data logging the two together you now 

have the airflow vs frequency of the second sensor assembly. 

 



23 

Tach Input Pulse Per Revolution 

The “Tach Input Pulse Per Revolution” setting is used to calibrate the 

RPM signal input to the MAF Fusion. This input wire is normally 

connected to the tachometer output wire from the ECM but may also 

be connected to the coil negative terminal or coil trigger wire in some 

applications. The RPM signal is only currently used by the MAF 

Fusion for auxiliary injection control but, since it is also data logged by the MAF Fusion, it may be 

helpful to have this connected even in applications not using the auxiliary injection control function. 

Available RPM pulse count configurations are as follows: 

 

The MAF Fusion software recognizes most common tachometer pulse frequencies. If your engine 

application is not accounted for, please contact Product & Service Solutions for technical assistance. 

Some newer vehicle applications may not have a tachometer output wire as delivered from the 
factory and will require adding a tachometer signal output wire to the ECM and enabling the signal 
output in the ECM, 

Tach Input Pullup Enable 

The Tach Input Pullup Enable is used to enable a pullup circuit in the 

MAF Fusion controller. 

If you are connecting to an existing tachometer wire already 

connected to something else in the vehicle then you do not normally need to enable this. If the ECM 

has a software or hardware enabled pullup turned on or if a pullup is wired into the system, do not 

also enable this pullup (only one pullup circuit should be in use). 

 

MAF Fusion menu choice 
Pulse/
rev 

Degrees/
pulse Common application(s) 

1 Pulse per Two Revolutions 0.5 720 
One cylinder engines & individual coil ignitions such as 
'99+ V8 Mustang, Suzuki Hayabusa, Kawasaki ZX-14. 

1 Pulse per Revolution 1 360 
Two cylinder engines and wasted spark coil packs 
including Viper/SRT10 coil 

2 Pulse per Revolution 2 180 
Typical 4 cylinder engines & GM Gen III, IV & V V8 engine 
tachometer signal (LS1, LS2 etc.) 

3 Pulse per Revolution 3 120 Typical 6 cylinder engines 

4 Pulse per Revolution 4 90 Typical 8 cylinder engines 

5 Pulse per Revolution 5 72 Typical 10 cylinder engines 
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Data Log Samples Per Second 

The MAF Fusion controller has onboard memory to allow data 

logging of the MAF Fusion data. The MAF Fusion software allows 

you to adjust the logging rate. Available logging rates are 10, 20, 50 

and 100 Hz (10, 20, 50 or 100 times per second). The higher the 

logging rate the shorter the amount of logging time available. 

With the onboard memory and the data currently being recorded, the available recording time at 

each sample rate is as follows: 

 

Data logging is enabled via the violet “Data Log Activation Input” wire on pin 15 of the controller. 

Data logging begins when you apply +12 volts to this wire and ends when you remove +12 volts or 

when the data logging memory is full (which ever happens first). 

The power LED will blink when the Data Log Activation Input is receiving +12 volts to indicate 

logging is occurring (but it will continue to blink when the data log is full). 

You must turn off the logging (remove +12 volts) before shutting off power to the MAF Fusion or the 

data log will not be saved properly. 

NOTE—if you apply +12volts to the data log enable wire again without reading out the data log your 

existing data log will be erased and a new data log will be generated. 

 

MAP Sensor Configuration 

MAP Sensor Configuration is used to calibrate the sensor signal 

being used to measure manifold air pressure. This can be a factory 

type MAP sensor or other linear output 0-5 volt pressure sensors and transducers. 

In many applications the input impedance on the MAF Fusion MAP sensor signal input is high 

enough that it can be safely connected to an existing MAP sensor signal wire as long as that sensor 

is a linear 0-5 volt type MAP sensor and you know the calibration curve for that sensor. We 

recommend checking the MAP sensor signal voltage as measured by the ECM to make sure the 

MAF Fusion does not impact the measured value. If the MAF Fusion is found to impact the MAP 

readings when it is connected to the existing MAP sensor then we recommend using a dedicated 

MAP sensor input to the MAF Fusion to prevent possible sensor signal errors. 

If the existing factory MAP sensor does not read to the desired MAP value then it is also 

recommended that you use a dedicated sensor for this signal. 

Several common sensor calibration curves are provided. These currently  include: 

Sample rate Log duration 

Hz Seconds 

10 623.3 

20 311.65 

50 124.66 
100 62.33 

Sensor Part # 

GM 3 bar 12223861 

GM LSA/LS9 12592525 

GM LS3/L99/LS7 55573248, 12591290 
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You can also enter your own custom sensor calibration values by 

selecting “Custom Sensor” from the bottom of the drop down menu. 

If you don’t know the calibration values for your sensor we 

recommend contacting the sensor supplier or manufacturer. We also recommend checking online 

as many on-line resources exist for the sensor calibration values for common OEM pressure 

sensors (GM, Delphi, Bosch, etc.) 

You can also use the Live Data view mode with an external pressure source and gauge to calibrate 

the sensor yourself. 

NOTE—the sensor must be a linear output 0-5 volt type sensor. 

The MAF Fusion software uses the same scalar and offset type sensor calibration values used to 

characterize the pressure sensors in many tuning/calibration software programs. The “Scalar” value 

is in mbar per 0.5 volts and is effectively the slope of the sensor output curve. 

The “Offset” value is in mbar and is the 0 volt axis pressure value (Y intercept). The MAF Fusion 

software accepts positive and negative Offset values. 

Example EFIlive MAP sensor calibration data: 

Example HP Tuners MAP sensor calibration data: 

Once you have entered the sensor calibration values you can click 

the view sensor data button to see what the resulting pressure vs 

voltage data will be for your selected sensor calibration. 

The manifold air pressure (MAP) reading is currently only used for auxiliary injection control but, 

since it is data logged, it may also be of interest to record this value in applications not using the 

auxiliary injection control capability of the MAF Fusion controller. 



26 

Notes—Configuration 

You may choose to type notes for this user configuration file in the 

notes area. A separate notes area exists for the Config, MAF Input 1, 

MAF Input 2, MAF Out Frequency and MAF Out Voltage tabs. 
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MAF Input1 & MAF Input2 tabs: 

 

The  MAF Input1 and MAF Input2 

tabs are used to calibrate the sensor 

output curves for the MAF sensors 

connected to Input1 and/or Input2. 

The input sensor calibration is 

frequency (Hz) vs airflow with airflow 

measured in grams/second. 

• The first column in the table 

represents the row number (1 to 

up to 250). 

• The second column is the sensor 

signal output frequency in Hz 

(pulses per second). 

• The third column is the airflow in 

grams/second corresponding to 

that output frequency. 

• The fourth column is the filter 

value at that frequency. 

• The fifth column is the filter compensation value at that frequency. 

The MAF frequency steps do not have to be even in step sizes but 

the frequency values can’t repeat and they must be in the table in 

proper numerical order (low to high). If an error exists in the 

frequency values (repeated value or value not in correct numerical 

order) then the next cell after the error will be highlighted in red. 

Airflow values are in grams per second (gps) and can range from -5 gps to 2,000 gps in 0.00001 gps 

increments. 

You can obtain the MAF sensor frequency vs airflow data by several methods including: 

• Use the PSS supplied sample MAF curves. 

• Copy the MAF sensor frequency vs airflow data from an existing engine calibration file. 

• Copy the MAF sensor frequency data from a manufacturer supplied flow sheet. 

• Send a MAF sensor out to be flow tested and then import that data into MAF Fusion. 

• Flow bench test the MAF sensor or air intake assembly yourself. 

To bring this data into the MAF Fusion software you can: 

• Import an existing CSV file (supplied with the MAF Fusion software or by a third party) 

• Copy and paste the data from other software (Excel, EFILive, HP Tuners) 

• Manually enter the data. 
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Importing MAF data as CSV files: 

We have provided example MAF sensor calibration curves for many common OEM MAF sensors. If 

you are using one of these MAF sensor air intake assemblies, you can import the MAF sensor 

calibration into the MAF Fusion software using the supplied CSV files. If you are using a similar air 

intake you may also be able to use one of these curves as a starting point for your MAF calibration. 

When importing an existing MAF sensor calibration curve as a CSV file you do not need to set the 

correct number of frequency steps. This gets done automatically when you import the file.  

To import a CSV file, go to the “File” menu and select “Import CSV 

Data” or click on the spreadsheet icon with the green arrow pointing 

to the left. 

You will be prompted to select a CSV file. The software will default to 

the “Documents>MAF Fusion>CSV Files” directory where the 

sample provides files are located. You may browse to a different 

location if you have saved a MAF sensor CSV file elsewhere on your 

PC. Select a file that represents the MAF sensor data you want to 

import. 

You will now be prompted to indicate which MAF Fusion table you 

want to populate with this data. The choices are: 

• MAF Input #1 

• MAF Input #2 

• MAF Output Frequency 

• MAF Output Voltage 

 

Select the MAF sensor location you want populated and press “Accept”. The number of rows, the 

frequency and the grams/second data for that sensor will be populated for that location. A graph of 

the sensor output curve will also be displayed at the bottom of the screen. Repeat the process for 

the second MAF sensor if you are using two MAF sensors. 

Make sure you select the correct MAF sensor, including the correct sensor output configuration 

(frequency or voltage). Only frequency type sensor curves should be imported into MAF Input #1 

and MAF Input #2. 

Please note – changes to air duct shape, diameter and sensor placement along with changes to 

filter design and placement will impact the MAF sensor calibration curve. 
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Manually entering MAF sensor data or copying it from other sources: 

If you are manually entering the sensor calibration data or copying it 

from another program (for example, your calibration software), you 

must first set the number of break points (MAF Table Size) to the 

correct number of break points used. To do so, you can type the 

correct number into the table size location and click on the “Apply” 

button or you can use the small up and down arrows to increment the table size and then click on 

the “Apply” button. 

To manually enter the data you will want to enter the frequency steps in the frequency column and 

the airflow values (in grams per second) into the gram/second column. This data could come from a 

manufacturer supplied flow sheet, calibration data or other sources. Make sure the frequency steps 

and the airflow steps increase order (low to high values). The frequency steps do not need to be 

even. If you find you need to increase the size of the table, you can increase the table size after you 

have started entering data. If you are using the MAF Input Table Size function at the top of the 

screen, the new rows will be added to the end (note they will be all zero values so they must get 

populated with valid data). 

You can also insert a row anywhere in between other rows if you 

missed a table value. To insert a row, select where you want the row 

inserted, right click and then select “Insert Row”. From the right click 

menu you can also delete a row. 

If you are copying the entire MAF curve data from an ECM table, 

make sure the number of rows in your source data and in MAF 

Fusion match. Then copy the two columns of data (frequency and 

airflow) in your other software. Note different programs copy data to 

the clipboard in different ways. In some cases it may be necessary to 

copy the data from a spreadsheet program like Microsoft Excel. This 

may require copying the data from your calibration software and then 

pasting it into Microsoft Excel first. Then highlight the Frequency and 

Gram/Second columns in the MAF Fusion software and right click to 

paste the data (or use the “CTRL-V” keyboard command). 

Be careful that some systems have multiple tables to provide the 

MAF calibration curve and the frequency points in each table may 

overlap (usually the end of one table and the beginning of the next). 

An example of this would be the 2005 Corvette (E40 ECM) and other similar vehicles. In this case 

the low flow portion of the table has one step size (150 Hz) and the high flow has a different step 

size (200 Hz) and the end of the low flow stops at 5800 Hz and the beginning of the high flow starts 

at 5800 Hz. You must remove this duplicate data frequency step when copying it into the MAF 

Fusion software. As seen in this example, also note that some systems may change the frequency 

step sizes so do not assume they are the same over the entire table. 
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The MAF sensor calibration curves for the different tables in the MAF Fusion software do not need 

to be the same. They can have different frequency steps sizes and airflow values. If you have the 

exact same MAF sensor assembly connected to MAF Input 1 and MAF Input 2, you can copy and 

paste the calibration data from Input1 to Input2.  

Input high and low table limit values: 

If the measured MAF sensor input frequency exceeds the maximum value in the MAF Fusion table 

for that sensor then the airflow will be set to the maximum value in the table (the value at the highest 

indicated frequency). In order for the MAF Fusion to properly measure high airflow readings we 

recommend that the MAF Input curves be populated with valid data that significantly exceeds the 

engine’s operating airflow range. 

If the measured MAF sensor input frequency is below the minimum frequency specified in the table 

then the airflow reading will be set to the minimum airflow value listed in the table (the airflow value 

at the lowest frequency listed). 

NOTE – A word of caution on using factory ECU MAF tables beyond the OEM flow range. Some 

vehicles will show data in the MAF table well beyond the factory airflow range but in some cases this 

data is not correct for the airflow sensor beyond a certain airflow. In some cases the data will 

become linear past a certain frequency point and the sensor’s frequency vs airflow will no longer 

correctly describe the sensor output curve. 

Examples of this include the production 2012-2013 

ZL1 Camaro (example shown to the right) and many 

GM truck MAF curves. In the production ZL1 

Camaro example shown to the right, the data in the 

calibration is plotted as the blue line whereas the 

output curve for the sensor extended to the full 

sensor output range is shown as the red line. As you 

can see, above roughly 500 gps and 9500 Hz, the 

factory data becomes linear but MAF sensor output 

is not linear so above 9500 Hz the factory calibration 

data is under-reporting the airflow. As the frequency 

increases the amount under-reported increases 

significantly. This results in airflow measurement 

errors and the ECU not commanding the correct amount of fuel to achieve the desired air fuel ratio. 

If this is the case and you will be operating outside the accurate part of the MAF calibration curve 

you must perform a curve fit of the data to get the correct airflow or you need to send your air intake 

and MAF assembly out to be flow tested to obtain a MAF curve over the desired range. 
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MAF Input1 & Input2 Filter & Compensation settings 

 

The MAF Fusion allows you to filter the MAF input readings for each 

MAF sensor. The filter variables can be adjusted at every frequency 

step. 

Two variables are used to adjust the filtering: 

• Filter 

• Compensation 

Filter, as the name implies, is a filter value indicating how large a 

sample size is being averaged for the filtering. This value ranges 

from 0 to 10 with 0 being OFF (no filtering) and 10 being the 

maximum amount of averaging (highest filter value). A value of 2 

means twice as many samples are being averaged as in filter setting 

1, 3 indicates three times as many as setting one,… and 10 indicated 

ten times as many samples as setting 1. 

Since this filter value is an indicator of the number of samples being averaged (NOT the amount of 

time), as the sensor output frequency goes up, the filtering is being applied over a shorter period of 

time for the same filter setting. 

The second variable is Compensation. Compensation is a variable that indicates the level of 

change in airflow signal required to disable filtering. This is used to allow rapid changes in airflow to 

disable filtering. 

The values for this variable can range from 0 to 9 with 0 being Compensation is OFF (no change in 

airflow will disable filtering). 9 results in the least filtering (the smallest change in airflow needed for 

filtering to be disabled). 

0 = Filtering will not be disabled by any change in airflow 

1 = 90 % change over 9 input signals disables filtering 

2 = 80 % change over 8 input signals disables filtering 

3 = 70 % change over 7 input signals disables filtering 

4 = 60 % change over 6 input signals disables filtering 

5 = 50 % change over 5 input signals disables filtering 

6 = 40 % change over 4 input signals disables filtering 

7 = 30 % change over 3 input signals disables filtering 

8 = 20 % change over 2 input signals disables filtering 

9 = 10 % change over 1 input signals disables filtering 

You can make global adjustments to these values by selecting the entire column and entering the 

value or change in value using the edit commands at the top of the screen. You can also select 

specific cells and manually enter the values in each cell. 

MAF Input#1 and MAF Input#2 can have different filtering values. 
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MAF Out Frequency tab: 

The MAF Out Frequency table is a lookup table used 

to define the airflow to frequency output of the MAF 

Fusion. This is normally used to provide the mass 

airflow reading to applications that accept frequency 

type MAF sensors (most late model GM vehicles 

etc.).  

The MAF Fusion software uses your assigned input 

mode from the “Config” tab and the airflow values 

from MAF Input#1 and/or MAF Input#2 to calculate the system 

airflow. This may be the combined output of Input #1 & #2, the 

average of #1 & #2, the airflow of just #1 or #2 or the airflow from #2 

subtracted from #1. This output airflow is also after any filtering that 

may be enabled. 

The MAF Fusion then uses the calculated system airflow to 

determine the output frequency using the look-up table in the MAF 

Out Frequency tab. 

If you are not connecting anything to the frequency output wires on 

the MAF Fusion you do not need to populate the data in this tab in 

the software. 

The MAF Out Frequency curve should normally be the same as the 

MAF calibration curve in your ECM. The step sizes do not need to be 

the same but the overall calibration curve should be the same if you 

want the ECM to read the same airflow as the MAF Fusion module. 

Just like the MAF Input tabs, you can import the MAF curve function 

into the MAF Out Frequency table, you can copy and paste or you 

can manually enter the data. 

No filter variables exist for the MAF Out Frequency tab because the 
filtering is done to the input signals, not the output value. 

When an airflow value is calculated by the MAF Fusion module that 
exceeds the maximum airflow value in the MAF Out Frequency table 
the MAF Fusion software will use the last frequency value in the table so the MAF Out frequency 
curve should be configured to exceed the maximum range of the ECU’s airflow table and the 
engine’s operating airflow range UNLESS you do not want to report anything higher than the last 
frequency value in the table to the ECU. 

When airflow output is below the minimum frequency value in the table, then the minimum frequency 
value will be transmitted. If the airflow output is above the maximum frequency value in the table 
then the maximum frequency value in the table will be transmitted. 

You may connect to both MAF outputs simultaneously (the frequency out and the voltage out). This 
allows you to send the airflow signal to two devices at once (ECM and data acquisition system, for 
example). 
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MAF Out Voltage tab: 

The MAF Out Voltage signal range is 0.1 volts 

(minimum) to 4.9 volts (maximum). 

The MAF Out Voltage table is a lookup table used to 

define the airflow to voltage output of the MAF 

Fusion. This is normally used to provide the mass 

airflow reading to applications that accept voltage 

type MAF sensors (many Ford applications, early 

GM EFI vehicles etc.) or to provide the airflow data 

to a data acquisition system or other device. 

The airflow value used for the MAF Out Voltage is the same airflow value used for the MAF Out 

Frequency. 

The MAF Fusion software uses your assigned input mode from the “Config” tab and the airflow 

values from MAF Input#1 and/or MAF Input#2 to calculate the system airflow. This may be the 

combined output of Input #1 & #2, the average of #1 & #2, the airflow of just #1 or #2 or the airflow 

from #2 subtracted from #1. This output airflow is also after any filtering that may be enabled. 

The MAF Fusion then uses the calculated system airflow to 

determine the output voltage using the look-up table in the MAF Out 

Voltage tab. 

If you are not connecting anything to the voltage output wires on the 

MAF Fusion you do not need to populate the data in this tab in the 

software. 

The MAF Out Volt curve should normally be the same as the MAF 

calibration curve in your ECM. The step sizes do not need to be the 

same but the overall calibration curve should be the same if you 

want the ECM to read the same airflow as the MAF Fusion module. 

Just like the MAF Input tabs, you can import the MAF curve function 

into the MAF Out Frequency table, you can copy and paste or you 

can manually enter the data. 

If you are importing existing data be sure to import voltage type MAF 

sensor values and not frequency type CSV files.  

No filter variables exist for the MAF Out Voltage tab because the 
filtering is done to the input signals, not the output value. 

When an airflow value is calculated by the MAF Fusion module that exceeds the maximum airflow 
value in the MAF Out Voltage table the MAF Fusion software will use the last voltage value in the 
table so the MAF Out Voltage curve should be configured to exceed the maximum range of the 
ECU’s airflow table and the engine’s operating airflow range UNLESS you do not want to report 
anything higher than the last voltage value in the table to the ECU. 

When airflow output is below the minimum voltage value in the table, then the minimum voltage 
value will be transmitted. If the airflow output is above the maximum voltage value in the table then 
the maximum voltage value in the table will be transmitted. 
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Aux Fuel tab: 

If you are not using the auxiliary injector control 

feature you do not need to populate this section. 

The Aux Fuel tab is used to define the auxiliary 

injector operation. This data is used to control the 

output of: 

• Aux Injector Output #1 

• Aux Injector Output #2 

• Aux Injector Out, Low Level +12V Push/Pull 

All three outputs can be used simultaneously. 

When active, all three injector outputs fire once per engine revolution (twice per cylinder event). All 

the injectors are fired simultaneously as a batch (batch fire, not sequentially). 

The values in the Aux Fuel table are in milliseconds (ms) of injector commanded on time. 

Outputs #1 and #2 can directly control up to four high impedance (10-14 ohm each) injectors per 

channel for a total of 8 high impedance fuel injectors. 

The Low Level output provides the same output function as Output #1 and #2 but it is a +12V low 

level Push/Pull control signal. This can be used to send a control signal to an external driver module 

in order to drive higher current injectors and solenoids. The Low Level output can not be used to 

drive injectors or other solenoids directly. 

The auxiliary injectors are controlled by a load vs RPM table defined in the Aux Fuel tab. The load 

axis is user selectable as either manifold air pressure (MAP) in psi or mass air flow (MAF) in grams/

second. You must have the corresponding load sensor connected and calibrated for the Aux Injector 

control output to function properly. 

To select your load axis, go to the upper left corner of the Aux Fuel 

tab and select the load axis you want from the pull down menu under 

“Aux Fuel Table Select” - the choices are: 

• MAF Out Grams/Second 

• MAP psi 

When using the MAP for load, keep in mind that 0 psi is atmospheric pressure, -15 psi is total 

vacuum, 15 psi is one atmosphere of boost, 30 psi is two atmospheres of boost etc. 

Both the RPM axis and the load axis may have up to 21 break points (column or row headings). The 

break points do not need to be evenly distributed. This allows you to increase the axis resolution in 

areas where it is needed (large changes in needed injector pulse width for small axis changes). The 

axis values must be in increasing order and you may not have duplicate axis values (row or column 

headings). 
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The allowed RPM axis values can range from 0 to 12,000 RPM. 

The allowed MAP axis values can range from –15 psi to +150 psi 

The allowed MAF axis values can range from 0 to 4000 grams/second. 

It is usually recommended that the axis values correspond to the operating range of the engine. 

Injector output when operating outside the table axis values: 

• When the engine RPM or load are below the minimum values defined in the Aux Fuel table, the 

injector outputs will be off. 

• When the engine RPM or load are above the maximum values defined in the Aux Fuel table, the 

injector outputs will be held at the last values in the corresponding table area. 

Once you have configured your axis variables you now need to define the minimum injector off time 

(in milliseconds) and the minimum injector on time (also in milliseconds). The minimum injector on-

time for most injectors is usually between 0.8 and 1.2 milliseconds. Below this minimum on-time 

most injectors are not repeatable for flow. 

These two variables are adjusted using the dialog boxes above the 

Aux Fuel table. You can manually enter a value and click on the 

“APPLY” button or you can use the up or down arrows to change the value and then press the 

“APPLY” button. 

You may be able to obtain recommended minimum injector on and off time values from your injector 

supplier or a manufacturer supplied data sheet. 

Minimum Injector Off Time, ms: 

The MAF Fusion software calculates the available injector pulse width time available at each RPM 

point and will not allow values higher than that value to be entered into the table. The higher the 

engine RPM, the shorter the time window available to fire the injector. The minimum injector off time 

further reduces the calculated available injection time by forcing the injector to be off for this amount 

of time prior to being fired again. The minimum injector off time can be adjusted from 0.1 to 2.0 ms.  

Minimum Injector On Time, ms: 

The minimum injector on time is the minimum amount of time the MAF Fusion will use for an injector 

on time in milliseconds of pulse width. Changing this value changes the minimum injector on pulse 

width value you can enter in the table. It also changes the value of any existing data if they are 

below the minimum. The minimum injector on time does not have any impact on the maximum 

injector pulse width time available. 

Editing injector on time values: 

Now you are ready to populate the table with the desired injector 

pulse widths. Each injector bank is pulsed once per engine 

revolution. The table will not let you enter values that exceed the 

maximum available pulse width (given the engine rpm and minimum 

off time value). It will also not let you enter values that are less than 

the minimum on time. 

You can select the entire table by clicking in the upper left corner of the table. You can select a 

column or row by clicking on that axis value heading. If you want to select multiple rows or columns 
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you click on the first column or row heading you want to select and then drag the pointer to the left or 

right of that column or row to select additional columns or rows. 

You can select an individual cell by click on just that specific cell. If you want to select a group of 

cells, select one cell in the corner of the area you want to select and then drag across the table with 

the pointer to select the range of cells you want to edit. 

Once you have select the cell or cells you want to 

edit, you can enter values using the table editor tools 

found above the Aux Fuel table.  You may either manually enter values in these editor tools or use 

the small black up and down arrows to increase or decrease the value already displayed. 

If you want to set all of the selected cells to a specific value, enter that value to the left of the “+ - =“ 

menu and then click on the equals sign. If you want to increase all of the values by that amount, click 

on the “+” sign. If you want to decrease all the values by that amount click on the “-” sign. 

If you want to change the selected cells by a percentage, enter that percentage to the right of the 

“percentage” value and then click the large blue up or down arrows to increase or decrease the 

selected cells by the corresponding percentage. 

If you select a single cell you can also manually enter the value in that cell via the keyboard. 

You can also copy and paste the cell values between other programs including Microsoft Excel. You 

can copy and paste the entire table or just certain sections. 
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Simulation tab: 

The simulation tab allows you to simulate what the 

output airflow (in grams/second) and the output 

frequency and voltage would be for your user 

configuration file. 

The items in gray are not adjustable. The items in 

the boxes with the white background can be 

changed to change your simulation. 

The MAF Input Mode comes from what you have selected in the Config tab. The airflow to frequency 

conversion for each of the MAF input sensors comes from the tables you have populated for MAF #1 

and #2. 

The output frequency and voltage our look-up values based on the data in the MAF Out tables. 

You can synchronize the two MAF inputs using the “Sync” check box on the 

left side of the screen. In this mode the two sliders are linked and the 

frequency output of the two sensors are fixed at the same value. You can 

change the input values for the MAF sensors by either dragging the blue 

sliders for each sensor (or either one for both when synchronized) or you can 

manually enter the Input#1 and #2 frequency directly in the text boxes next to 

the variable name.  You can also use the small black up and down arrows to 

increment the input frequency in one Hz increments. 

The simulation mode does not change any of the actual signal outputs—it is 

only a simulation of the data to show you what it should look like. 
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Data tab: 

The data tab is used to view logged MAF Fusion 

data. It is also allows you to load the user 

configuration file (setup file) from the open data log, 

copy the data being viewed to the clipboard and 

export the data. 

You can open an existing data log by selecting Open Log Data from 

File from the Data menu or by clicking on the corresponding icon in 

the icon menu (data graph with a file in front of it icon). 

The MAF Fusion software will default to the “Documents>MAF 

Fusion>Data Log” folder for saved data logs. Select the file you want 

to view and click Open. If the log file you want to open is saved 

elsewhere, navigate to that directory to open the file. MAF Fusion 

data log files are saved as a “.mfd” Windows extension.  

The selected file will open. The name of the open file 

will now be shown at the bottom of the screen. 

At the top of the window you will see a grid showing 

the numeric values for each variable at the current 

position of the cursor. Below the data grid will be 

graphs of all of the logged data. 

You can click on the data in the upper area to 

remove or add it to the graph. When you select a 

variable to add it to the graph that variable will be the 

highlighted variable in the graph with the left axis now showing the units for that variable. Above the 

graph to the right will be the current, min and max values being displayed for that variable. The 

minimum and maximum values shown are for the entire log file, not just for the area currently being 

viewed. The current value being shown is for where the cursor is currently located. 

You can Zoom In our Out of the graph using the Zoom buttons at the bottom of the graph. The 

keyboard commands for zooming are “i” to zoom in and “o” to zoom out. 

You can click on the graph to move the cursor on the graph or you can use the left and right arrows 

to scroll. For finer resolution when scrolling use the “CTRL”+ arrow keys and for the finest resolution 

use the “SHIFT” + arrow keys. 
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If you want to view the settings in the current data log, you can load 

the setup using the “Load Setup From Data Log” button at the 

bottom of the screen. Once you click that button the configuration 

settings will be populated based on what is stored in the data log. 

If you have made user configuration settings changes to the current file MAF Fusion will prompt you 

with “Settings have changed. Save user Setup file?” before it will let 

you import the data log configuration data. Select Yes if you want to 

save those changes before loading the setup file configuration 

values (you will then be prompted for a filename for your existing 

user setup). Select No if you don’t want to save the changes to the 

already open user setup. 

You will then get a dialog box indicating the setup has been read 

from the data log. 

With the a data log file open you can also export the data to a CSV 

file or copy it to the clipboard to paste it into some other program. 

To copy to the clipboard, with a data log open click the “Copy CSV 

Data” button at the bottom right of the Data View window. The data 

will then be saved in the Windows clipboard. You can now go to 

another program, such as a text editor or spreadsheet program, and paste the data into that 

program. 

To export to a CSV file, with a data log open, click the “Export to 

CSV File” button at the bottom right of the Data View window. A 

“Save As” Windows dialog box will appear. The default file name will 

be the data log name but with a .csv extension. The default directory 

for saving these files is the “Documents>MAF Fusion>CSV” Files 

directory. 

Read a new data log from the MAF Fusion controller 

If you are connected to the MAF Fusion and a saved data log exists 

in the controller, you can read the log file from the MAF Fusion by 

selecting the “Read Log Data from Controller” option or by clicking 

on the corresponding icon in the icon menu (data graph image with 

no other graphics in the icon). 

 

You will then be prompted to save the file. The default file naming 

convention used by MAF Fusion for log files is the word “Data” and 

then the day, date and time. 
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Live Data tab: 

The live data tab allows you to view live data from 

the MAF Fusion when you are connected via a USB 

cable.  

For Live Data to function the MAF Fusion software 

must show the MAF Fusion controller to be 

connected (bottom left corner of the screen should 

indicate “MAF Fusion Controlled Connected”. 

In Live Dave view the following data variables are 

shown: 

• MAF Input #1 

• Raw Frequency (Hz) 

• Frequency (Hz)  [this is filtered frequency] 

• Airflow (grams/second) 

• Filter [current value for MAF Input#1] 

• Compensation [current value for MAF Input #1] 

• MAF Input #2 

• Raw Frequency (Hz) 

• Frequency (Hz)  [this is filtered frequency] 

• Airflow (grams/second) 

• Filter [current value for MAF Input#2] 

• Compensation [current value for MAF Input #2] 

• MAF Output 

• Output Frequency (Hz) 

• Output Voltage (vdc) 

• Output Air Flow (grams/second) 

• Engine RPM 

• Battery Voltage 

• MAP Sensor Input 

• Volts 

• Pressure (psi) 

• Barometric pressure (hPa) 

• MAF Fusion temperature (degrees F) 

• Injector on time (ms) 
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LED operation: 

The MAF Fusion has three light emitting diodes (LED) on the module. The LEDs are red/green LEDs 

so they can be either red or green in color. 

These LEDs are labeled as follows: 

• Power 

• Status 1 

• Status 2 

The Power LED has the following modes: 

• Blinking red indicates the unit has power but no 

valid MAF signals are present 

• Solid green indicates the unit has power and has the MAF signal(s) needed for the MAF Input 

Mode selected.  

• If Average, Combine or Subtract are selected two MAF signals must exist for it to be solid 

green. 

• If in MAF Input #1 Only mode then MAF Input #1 signal must exist 

• If in MAF Input #2 Only mode then MAF Input #2 signal must exist 

• Blinking green indicates the data log is enabled and no error code exists 

• Blinking green and red indicates the data log is enabled AND an error condition exists 

The Status 1 and 2 LEDs are used to indicate the status of MAF Input1 and MAF Input2. The have 

the following modes: 

• Solid red indicates no valid signal. 

• Solid green indicates a MAF signal is present 
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Creating new MAF sensor CSV files: 

You can generate your own MAF sensor CSV files to be used with future configurations. 

Two primary methods exist to do this. 

The first method is to create the desired MAF curve in the MAF 

Fusion software (in the MAF input or output tabs). Then from within 

the MAF Fusion software you can select “Export CSV Data” from the 

File menu. You can also use the icon that looks like a spreadsheet 

with a red arrow point to the right to perform the same 

function. 

 

Select which MAF sensor curve you want to export and then select Accept. A “Save As” dialog box 

will come up. The default file save location for the CSV file is the “Documents>MAF Fusion>CSV 

Files” folder. The default name is the user setup file name but with the .csv file extension. We 

recommend renaming the file to something that indicates the MAF sensor configuration. 

The other way to generate a MAF sensor CSV file is to save the data from within a program like 

Excel. Be sure to look at other example files to make sure you have the correct formatting. The units 

(frequency and gram/second) should be the values at the top of column A and B. Then the 

frequency and airflow values should be in the rows below them. Enter the data into the spreadsheet 

and then perform a “SAVE AS” to save the file as a CSV (Comma delimited) file. 
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MAF sensor additional information and resources: 

The mass airflow measurements in this software are all listed in grams per second (gps). If you 

have data in other units, here are the conversion factors for some of the other common airflow 

measurement units: 

• Lbs/hr to grams/second1 lbs/hr 

•  To convert from lbs/hr to grams/second, multiply by 0.125997 

• Grams/second to lbs/hr 

•  To convert from grams/second to lbs/hr, divide grams/second by 0.125997 

Some MAF sensor calibration curves use the period instead of frequency for the primary axis. The 

period is just the inverse of the frequency. But you also have to convert the units of time. The 

frequency is in pulses per second (Hz). Some systems my have the period in microseconds (one 

millionth of a second).  

• Frequency (in Hz) =  (1 / period (in microseconds)) * 1,000,000 

• For example: 

• 450 microsecond period 

• Frequency (Hz) = (1/450)*1,000,000 

• Frequency (Hz) = 2222 

Some systems also have the axis values in ascending order (high frequency to low frequency). To 

avoid having to retype this data you can copy the data into Excel or some other spreadsheet and 

sort in descending order (smallest to largest) by the frequency axis. Make sure you select the 

frequency data and the airflow data so that both are sorted together. 

 

 



44 

 Common tachometer ECU signal wire information  

Make  Model  Year(s)  ECM  Connector  Pin  Wire 
color  

Circuit #  Pulse per 
rev setting  

Enabled in 
stock ECU**  

#* Color 

Chevrolet Camaro 1996-1997 32U C1 red 13 white 121 4 Yes 

Chevrolet Camaro 1998 Warren C2 blue 35 white 121 2 Yes 

Chevrolet Camaro 1999-2002 Warren C2 red 10 white 121 2 Yes 

Chevrolet Camaro 2010-2015 E38 C1 black 48 N/A N/A 2 No 

Chevrolet ZL1 Camaro 2012-2015 E67 C1 blue 25         

Chevrolet Camaro 2016-2019 E92 X2 black 39 white 121   Yes 

Chevrolet ZL1 Camaro 2017-2019 E92 X2 black 39         

Chevrolet Corvette 1995-1996 32U C1  red 13 white 121 4 Yes 

Chevrolet Corvette 1997-1998 Warren C2 blue 35 white 121 2 Yes 

Chevrolet Corvette 1999-2003 Warren C2 red 10 white 121 2 Yes 

Chevrolet Corvette 2004 Warren C2 green 10 white 121 2 Yes 

Chevrolet Corvette 2005 E40 C1 blue 48 white 121 2 Yes 

Chevrolet Corvette 2006-2013 E38 C1 black 48 white 121 2 Yes 

Chevrolet Z06 Corvette 2006-2013 E38 C1 black 48 white 121 2 Yes 

Chevrolet ZR1 Corvette 2009-2013 E67 C1 blue 25 white 121 2 Yes 

Chevrolet Corvette 2014-2019 E92 X2 black 39 light green/
black 

3633   Yes 

Chevrolet Z06 Corvette 2015-2019 E92 X2 black 39 light green/
black 

3633   Yes 

Chevrolet ZR1 Corvette 2019 E99               

Chevrolet SSR 2003-2004 Warren C2 blue 10 white 121 2 Yes 

Chevrolet SSR 2005-2006 E40 C1 blue 48 white 121 2 Yes 

Chevrolet Trailblazer SS 2006 E40 C1 blue 48 white 121 2 Yes 

Chevrolet Trailblazer SS 2007-2009 E67 C1 blue 25 white 121 2 Yes 

Cadillac CTS-V 2004-2005 Warren C2 green 10 white 121 2 Yes 

Cadillac CTS-V 2006-2007 E67 C1 blue 25 white 121 2 Yes 

Cadillac CTS-V 2009-2015 E67 C1 blue 25 N/A N/A 2 No 

Cadillac CTS-V 2016-2019 E92 X2 black 39 white 121   Yes 

GM C/K truck*** 2000-2006 Warren C2 red or 10 white 121 2 Yes 

GM C/K truck*** 2007-2013 E38 C1 black 48 N/A N/A 2 No 

GM C/K truck*** 2014-2019 E92               

GM C/K truck*** 2007-2019 E78               

Pontiac Firebird 1996-1997 32U C1 red 13 white 121 4 Yes 

Pontiac Firebird 1998 Warren C2 blue 35 white 121 2 Yes 

Pontiac Firebird 1999-2002 Warren C2 red 10 white 121 2 Yes 

Pontiac GTO 2004 Warren C2 green 10 Brown 121 2 Yes 

Pontiac GTO 2005-2006 E40 C1 blue 48 Brown 121 2 Yes 

Pontiac G8 2008-2009 E38 C1 black 48     2   

Ford  Mustang GT 2011-2012   70 way 
(bottom) 

  10 N/A N/A   Yes 

*Connectors C1, C2 and C3 (or X1 and X2) are the term used in the service documents and may be labeled as J1, J2 and J3 on the ECM itself.  

**If the tachometer output is not enabled in the stock ECU you will need to reprogram the ECU to enable the tachometer signal output.  

***GM C/K trucks include: Avalanche, Suburban, Tahoe, Yukon, Silverado, Sierra, Escalade & H2  
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Limited Warranty 

Product & Service Solutions LLC (PSS) warrants, to the original purchaser, the MF-001 MAF Fusion product to be free from defects 

in materials and workmanship under normal use for a period of twelve months from the original purchase date. If the product is 

found to be defective per above, it will be replaced or repaired if returned prepaid along with proof of the date of purchase. This 

shall constitute the sole remedy of the purchase and the sole liability of PSS. To the extent permitted by law, the foregoing is 

exclusive and in lieu of all other warranties or representations whether expressed or implied, including any implied warranty of 

merchantability or fitness. In no event shall LPE be liable for special or consequential damages. The warranty only covers the 

product itself and not the cost of removal and re-installation of the product. 

Specific conditions that will VOID the product warranty: If the product has been opened, modified or repaired. If the product was 

not installed or used correctly. If the product has been tampered with by: negligence, misuse or accident. If the product is returned 

without explanation of the problem or Return Authorization. 

Contact PSS at info@proservsolutions.com for a Return Authorization Number. 

All warranty returns should be returned freight pre-paid and should include inside of the box: 

• Proof of Purchase 

• Letter that contains both the Return Authorization Number and a detailed explanation of the reason for the return. 

The Return Authorization Number should also be clearly written on the outside of the box. 

Send all returns to: 

PSS MAF Warranty 

6435 W Jefferson Blvd., Suite 208 

Fort Wayne, IN 46804 


